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4.1. Drawing Basic Shapes  

The software provides a drawing tool you can use to create simple or elaborate drawing shapes such as lines, rectangles, 
circles, arcs etc.  
 
To create a drawing shape, click the shape on the Draw Toolbar (See Section 1.4.2.3 Draw Toolbar for details), or use the 
command on the Draw menu (See Section 1.4.1.5 Draw menu for details). Then, move the mouse to the position you want 
to place the shape and click the left button. To set up a drawing shape, double-click the shape to bring up the 
corresponding properties dialog, which can then allow you to set up the color and style of the line/outlined, pattern, FG/BG 
Color…of the shape. 
 
Note: If you don’t see the Draw Toolbar pictured below in the lower left corner of the program window, please click the 
Draw Toolbar command on the View menu. 

 
 
The following is a sample of the basic shapes: 
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4.1.1. Drawing Dots 

1. In the Draw menu or Draw toolbar, click Dot . 

2.  Move the cursor onto the screen where you want to draw a dot. A dot with default settings will display and move 
along with the cursor. 

3.  Click the desired position on the screen to place the dot. The center of the dot will be at the clicked position. 

4.  Double-click the dot to bring up the Dot dialog box and then modify the settings of the dot.  
 

The following is an example of the Dot dialog box. 

 

 
 

The following table describes each property in the Dot dialog box. 

Property Description 

Style 

Select one of the dot styles listed below:  

 

Color Specifies the dot color. 
X Specifies the X coordinate of the upper-left corner of the dot. 

Position 
Y Specifies the Y coordinate of the upper-left corner of the dot. 

 

5.  You can click the following icons in the Draw toolbar to modify the properties of the dot. 

Click Icon To 

 
Select a style for the dot. 

 
Select a color for the dot. 

CHAPTER 4   DESIGNING SCREENS  



4 4  
 

 

 
4-3 

 

4.1.2. Drawing Lines 

1.  In the Draw menu or Draw toolbar, click Line  to draw a straight line. You can also click Horizontal Line  

to draw a horizontal line or click Vertical Line  to draw a vertical line. 

2.  Move the cursor onto the screen where you want to draw a line. A line with default settings will display and move 
along with the cursor. 

3.  Click the desired position on the screen to place the line. The start point of the line will be at the clicked position. 

4.  Drag the handle at the start point to adjust the position of the start point. Drag the handle at the end point to adjust 
the position of the end point. 

The picture on the left shows the two handles of a line. Position the mouse 
pointer over one of the handles. When the cursor changes to , drag the handle 
until the line has the length and slope you want.  

 

 
 
5.  Left-click and hold down the mouse button until the cursor becomes a cross icon  to move the line. 

6.  Double-click the line to bring up the Line dialog box and then modify the settings of the line. The following is a 
sample of the Line dialog box. 
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The following table describes each property in the Line dialog box. 

Property Description 
Type Specifies the type of line: General, Horizontal, or Vertical. 
Style 

                     
Static Check this option if the color of the line will not be changed. 
Controlled By Bit Check this option if the color of the line will be controlled by the specified bit.
Blink Check this option so the line will blink. You have to choose the blink effects 

that change the color of the line from its On state color to Off state color.  
Blink(Enabled by Bit) Check this option if you want to enable the line blinking by the specified bit.
State Select the state that you want to view or define the color for. 
Color Specifies the line color for the selected state. 

Color 

Control Bit Specifies the bit that controls the color or enables the color blinking.  

Click  to enter the bit address. Click  to enter the bit tag. 
Start/End Point Select this option if you want the line to have a shape at the start/end point. 
Type Click the dropdown list to select the type for Start/End Point 

                                    

Filled Select this option if you want the shape to be filled with the line color. 

Start / End 
Point 

Size Specifies the shape size. 
Visibility Controlled 
By Bit 

Check this option if the line will be shown or hidden by the specified bit. 

Control Bit Specifies the bit that shows or hides the object.  

Click  to enter the bit address. Click  to enter the bit tag. 

Visibility 
Control 

Visible State Specifies the state (On or Off) that makes the line visible. 
X1 The X coordinate of the start point. 
Y1 The Y coordinate of the start point. 
X2 The X coordinate of the end point. 

Terminal 

Y2 The Y coordinate of the end point. 

Click the button to select the 
line style from the dropdown 
window shown on the right: 

End Point Type: Start Point Type:

 

7.  You can click the following icons in the Draw toolbar to modify the properties of the line. 

Click Icon To 

 
Select a style for the line. 

 
Select a color for the line. 
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4.1.3. Drawing Polylines 

1.  In the Draw menu or Draw toolbar, click Polyline to draw a polyline. 

2.  Move the cursor onto the screen where you want to draw a polyline, and click the position where you want the start 
point of the polyline to be at. 

3.  Continue clicking on the screen to place as many points needed for nodes in the polyline. 

4.  Right-click to place the last point for the polyline and complete the polyline. 

5.  Drag one blue handle of the polyline at a time to resize the polyline.  

6.  Drag one black handle of the polyline at a time to adjust the node positions of the polyline.  

 

The picture on the left shows all the blue and black handles of a polyline. 
Position the mouse pointer over one of the handles. When the cursor 
changes to  or  or  or , drag the handle until the polyline is 
the shape and size you want.  
 

7.  Right-click anywhere on the polyline and use the Insert Point command on the object pop-up menu to insert a new 
point for the polyline. Or right-click the existing point of the polyline and use the Delete Point command on the object 
pop-up menu to delete the point. 

Pop-up menu Description 

Insert Point 

Add a point at the specified position. 

   
 

Delete Point 

Delete a selected point. 
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8.  Double-click the polyline to bring up the Polyline dialog box and then modify the settings of the polyline. 

 

The following is a sample of the Polyline dialog box. 

 

 

The following table describes each property in the Polyline dialog box. 

Property Description 
Line Style Specifies the style of the polyline. 

Static Check this option if the color of the polyline will not be changed. 
Controlled By Bit Check this option if the color of the polyline will be controlled by the specified 

bit. 
Blink Check this option so the polyline will blink. You have to choose the blink 

effects that change the color of the polyline from its On state color to Off state 
color.  

Blink(Enabled by 
Bit) 

Check this option if you want to enable the polyline blinking by the specified 
bit. 

State Select the state that you want to view or define the color for. 
Color Specifies the line color for the selected state. 

Color 

Control Bit Specifies the bit that controls the color or enables the color blinking.  

Click  to enter the bit address. Click  to enter the bit tag. 
Start Point Select this option if you want the polyline to have a shape at the start point. 
Type Specifies the shape type. 
Filled Select this option if you want the shape to be filled with the line color. 

Start Point 

Size Specifies the shape size. 
End Point Select this option if you want the polyline to have a shape at the end point. 
Type Specifies the shape type. 
Filled Select this option if you want the shape to be filled with the line color. 

End Point 

Size Specifies the shape size. 
Continued  
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Property Description 

Visibility Controlled 
By Bit 

Check this option if the polyline will be shown or hidden by the specified bit. 

Control Bit Specifies the bit that shows or hides the polyline.  

Click  to enter the bit address. Click  to enter the bit tag. 

Visibility 
Control 

Visible State Specifies the state (On or Off) that makes the line visible. 
Left The X coordinate of the upper-left corner of the bounding rectangle of the 

polyline. 
Top The Y coordinate of the upper-left corner of the bounding rectangle of the 

polyline. 
Width The width of the bounding rectangle of the polyline. 

Profile 

Height The height of the bounding rectangle of the polyline. 
 

9.  You can click the following icons in the Draw toolbar to modify the properties of the polyline. 

Click Icon To 

 
Select a style for the polyline. 

 
Select a color for the polyline. 
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4.1.4. Drawing Rectangles 

1.  In the Draw menu or Draw toolbar, click Rectangle to draw a normal rectangle. You can also click Round 

Rectangle to draw a round rectangle or click Clipped Rectangle to draw a clipped rectangle. 
2.  Move the cursor onto the screen where you want to draw a rectangle. A rectangle with default settings will display 

and move along with the cursor.  
3.  Click the desired position on the screen to place the rectangle. The upper-left corner of the rectangle will be at the 

clicked position.  
4.  Drag one handle of the rectangle at a time to resize the rectangle. 

The picture on the left shows the eight handles of a rectangle. Position the mouse pointer 
over one of the handles. When the cursor changes to  or  or  or , drag the 
handle until the rectangle is the shape and size you want.   

5.  Double-click the rectangle to bring up the Rectangle dialog box and then modify the settings of the rectangle. The 
following is a sample of the Rectangle dialog box. 

 

 

The following table describes each property in the Rectangle dialog box. 

Property Description 

Type 

Specifies the type of the rectangle. There are three types: Normal, Round, or Clipped. 

Normal Round Clipped 

    
Continued  
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Property Description 
Number 
of Dots 

Specifies the size of the clipped corners if the rectangle is a clipped rectangle. Specifies the radius 
of the round corners if the rectangle is a round rectangle. 

3D 

Specifies the 3D visual effect for the rectangle. There are three effects: Flat, Raised, or Sunken. 

Effects Samples Description 
Flat 

 

You can specify the Color and 
Style for the Border if it is 
selected.  
 
Thickness field is not available 
when flat is selected.  

Raised 

 

You can specify the color for the 
top and left edges. The software 
will darken the specified color 
and draw in the bottom and right 
edges for you. 
 
Border and Style field is not 
available when Raised is 
selected. 
 

Sunken 

 

You can specify the color for the 
bottom and right edges. The 
software will darken the specified 
color and draw in the top and left 
edges for you. 
 
Border and Style field is not 
available when Sunken is 
selected. 

 
Continued  
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Property Description 

Static Check this option if the color of the rectangle will not be changed. 

Controlled By Bit Check this option if the color of the rectangle will be controlled by the specified 
bit. 

Blink Check this option so the rectangle will blink. You have to choose the blink 
effects that change the color of the rectangle from its On state Border and Solid 
option settings to Off state Border and Solid option settings.  

Blink(Enabled by 
Bit) 

Check this option if you want to enable the rectangle blinking by the specified 
bit. 

Color 
Control 

Control Bit 
Specifies the bit that controls the color or enables the blinking.  

Click  to enter the bit address. Click  to enter the bit tag. 
State Select the state that you want to view or define the colors for. 

Border Check this option if you want the rectangle to have a border. 
Thickness Specifies the thickness of the border.  
Color Specifies the border color for the selected state. 

Border 

Style Select a line style for the border. 

Solid 
Check this option if you want the rectangle to be solid. A solid rectangle is filled 
with the specified pattern and colors. This field is available when Border is 
selected. 

Pattern Specifies the fill pattern for the selected state. 

FG Color Specifies the color for the selected state that will be used for painting the black 
part of the fill pattern. 

Solid 

BG Color Specifies the color for the selected state that will be used for painting the white 
part of the fill pattern. 

Left The X coordinate of the upper-left corner of the rectangle.  
Top The Y coordinate of the upper-left corner of the rectangle. 
Width The width of the rectangle. 

Profile 

 

Height The height of the rectangle. 
Visibility 
Controlled By Bit Check this option if the rectangle will be shown or hidden by the specified bit. 

Control Bit 
Specifies the bit that shows or hides the rectangle.  

Click  to enter the bit address. Click  to enter the bit tag. 

Visibility 
Control 

Visible State Specifies the state (On or Off) that makes the rectangle visible. 

6.  You can click the following icons in the Draw toolbar to modify the properties of the rectangle. 

Click Icon To 

 
Select a line style for the border. 

 
Select a color for the border. 

 
Select a color for painting the white part of the fill pattern. 

 
Select a pattern for the fill pattern. 

 
Select a color for painting the black part of the fill pattern. 
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4.1.5. Drawing Circles 

1.  In the Draw menu or Draw toolbar, click Circle to draw a circle. 

2.  Move the cursor onto the screen where you want to draw a circle. A circle with default settings will display and move 
along with the cursor. 

3. Click the desired position on the screen to place the circle. The center of the circle will be at the clicked position. 

4. Position the mouse pointer over the handle on the edge of the circle. When the cursor changes to  or , drag 
the handle until the circle is the size you want. 

5. Position the mouse pointer over the handle on the center of the circle. When the cursor changes to , left-click the 
center and hold down the button to move the circle. 

 

The picture on the left shows the two handles of a circle. 

6.  Double-click the circle to bring up the Circle dialog box to modify the settings of the circle.  

The following is a sample of the Circle dialog box. 
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The following table describes each property in the Circle dialog box. 

Property Description 
Static Check this option if the color of the circle will not be changed. 

Controlled By Bit Check this option if the color of the circle will be controlled by the specified bit. 
Blink Check this option so the circle will blink. You have to choose the blink effects 

that change the color of the circle from its On state Outlined and Solid option 
settings to Off state Outlined and Solid option settings.  

Blink(Enabled by 
Bit) 

Check this option if you want to enable the rectangle blinking by the specified 
bit. 

Color 
Control 

Control Bit Specifies the bit that controls the color or enables the blinking. 

Click  to enter the bit address. Click  to enter the bit tag. 
State Select the state that you want to view or define the colors for. 

Outlined Check this option if you want the circle to be outlined. Outline 
Color Specifies the outline color for the selected state. 
Solid Check this option if you want the circle to be solid. A solid circle is filled with the 

specified pattern and colors. 
Pattern Specifies the fill pattern for the selected state. 
FG Color Specifies the color for the selected state that will be used for painting the black 

part of the fill pattern. 

Solid 

BG Color Specifies the color for the selected state that will be used for painting the white 
part of the fill pattern. 

X The X coordinate of the center of the circle. 
Y The Y coordinate of the center of the circle. 

Center 
& 
Radius 

Radius The radius of the circle. 
Visibility 
Controlled By Bit 

Check this option if the circle will be shown or hidden by the specified bit. 

Control Bit Specifies the bit that shows or hides the circle.  

Click  to enter the bit address. Click  to enter the bit tag. 

Visibility 
Control 

Visible State Specifies the state (On or Off) that makes the circle visible. 
 

7.  You can click the following icons in the Draw toolbar to modify the properties of the circle. 

Click Icon To 

 
Select a color for the outline. 

 
Select a color for painting the white part of the fill pattern. 

 
Select a pattern for the fill pattern. 

 
Select a color for painting the black part of the fill pattern. 
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4.1.6. Drawing Ellipses 

1.  In the Draw menu or Draw toolbar, click Ellipse to draw an ellipse. 

2.  Move the cursor onto the screen where you want to draw an ellipse. An ellipse with default settings will display and 
move along with the cursor. 

3.  Click the desired position on the screen to place the ellipse. The upper-left corner of the bounding rectangle of the 
ellipse will be at the clicked position. 

4.  Drag one handle of the ellipse at a time to resize the ellipse.  

 

The picture on the left shows the eight handles of an ellipse. Position the mouse pointer 
over one of the handles. When the cursor changes to  or  or  or , drag the 
handle until the rectangle is the shape and size you want.  

5.  Double-click the ellipse to bring up the Ellipse dialog box and then modify the settings of the ellipse.  

The following is a sample of the Ellipse dialog box.  
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The following table describes each property in the Ellipse dialog box. 

Property Description 
Static Check this option if the color of the ellipse will not be changed. 

Controlled By Bit Check this option if the color of the ellipse will be controlled by the specified bit. 
Blink Check this option so the ellipse will blink. You have to choose the blink effects 

that change the color of the ellipse from its On state Outlined and Solid option 
settings to Off state Outlined and Solid option settings.  

Blink(Enabled by 
Bit) 

Check this option if you want to enable the ellipse blinking by the specified bit. 

Color 
Control 

Control Bit Specifies the bit that controls the color or enables the blinking.  

Click  to enter the bit address. Click  to enter the bit tag. 
State Select the state that you want to view or define the colors for. 

Outlined Check this option if you want the ellipse to be outlined. Outline 
Color Specifies the outline color for the selected state. 
Solid Check this option if you want the ellipse to be solid. A solid ellipse is filled with 

the specified pattern and colors. 
Pattern Specifies the fill pattern for the selected state. 
FG Color Specifies the color for the selected state that will be used for painting the black 

part of the fill pattern. 

Solid 

BG Color Specifies the color for the selected state that will be used for painting the white 
part of the fill pattern. 

Left The X coordinate of the upper-left corner of the bounding rectangle of the ellipse.
Top The Y coordinate of the upper-left corner of the bounding rectangle of the ellipse.
Width The width of the bounding rectangle of the ellipse. 

Profile 

Height The height of the bounding rectangle of the ellipse. 
Visibility 
Controlled By Bit 

Check this option if the ellipse will be shown or hidden by the specified bit. 

Control Bit Specifies the bit that shows or hides the ellipse. 

Click  to enter the bit address. Click  to enter the bit tag. 

Visibility 
Control 

Visible State Specifies the state (On or Off) that makes the ellipse visible. 
 

6.  You can click the following icons in the Draw toolbar to modify the properties of the ellipse. 

Click Icon To 

 
Select a color for the outline. 

 
Select a color for painting the white part of the fill pattern. 

 
Select a pattern for the fill pattern. 

 
Select a color for painting the black part of the fill pattern. 
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4.1.7. Drawing Arcs 

1.  In the Draw menu or Draw toolbar, click Arc to draw an arc. 

2.  Move the cursor onto the screen where you want to draw an arc. An arc with default settings will display and move 
along with the cursor. 

3.  Click the desired position on the screen to place the arc. The upper-left corner of the bounding rectangle of the arc 
will be at the clicked position. 

4.  Drag one handle of the arc at a time to change the shape of the arc.  

The picture on the left shows the handles of an arc. The blue handles are for shaping the 
arc. The black handles of the two ends of the arc are for changing the ends' angles. The 
black handle at the center of the arc is for forcing the arc to be a part of a circle. 

Position the mouse pointer over one of the handles. When the cursor changes to  or 
 or  or , drag the handle until the arc is the shape and size you want.   

5.  Double-click the arc to bring up the Arc dialog box and then modify the settings of the arc.  

 

The following is a sample of the Arc dialog box. 

 

 

The following table describes each property in the Arc dialog box. 

Property Description 
Color Specifies the color of the arc. 

Left The X coordinate of the upper-left corner of the bounding rectangle of the arc. 
Top The Y coordinate of the upper-left corner of the bounding rectangle of the arc. 
Width The width of the bounding rectangle of the arc. 

Profile 

Height The height of the bounding rectangle of the arc. 
 

6.  You can click the following icons in the Draw toolbar to modify the properties of the arc. 

Click Icon To 

 
Select a color for the arc. 
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4.1.8. Drawing Pie Shapes 

1.  In the Draw menu or Draw toolbar, click Pie to draw a pie shape. 

2.  Move the cursor onto the screen where you want to draw a pie shape. A pie shape with default settings will display 
and move along with the cursor. 

3.  Click the desired position on the screen to place the pie shape. The upper-left corner of the bounding rectangle of 
the pie shape will be at the clicked position. 

4.  Drag one handle of the pie shape at a time to change the pie shape.  

CHAPTER 4   DESIGNING SCREENS  

 

5.  Double-click the pie shape to bring up the Pie dialog box to modify the settings of the pie shape.  

The picture on the left shows the handles of a pie shape. The blue handles are for 
changing the pie shape. The black handles at the two ends of the pie are for 
changing the size of the pie. Clicking the black handle at the center of the pie 
applies the radius to the entire pie and can be used to change the radius of the 
pie. 

Position the mouse pointer over one of the handles. When the cursor changes to
 or  or  or , drag the handle until the pie is the shape and size you 

t

 
The following table describes each property in the Pie dialog box. 

Property Description 
Outlined Check this option if you want the pie shape to be outlined. Outline 
Color Specifies the outline color. 
Solid Check this option if you want the pie shape to be solid. A solid pie shape is filled with the 

specified pattern and colors. 
Pattern Specifies the fill pattern. 
FG Color Specifies the color that will be used for painting the black part of the fill pattern. 

Solid 

BG Color Specifies the color that will be used for painting the white part of the fill pattern. 
Left The X coordinate of the upper-left corner of the bounding rectangle of the pie shape. 
Top The Y coordinate of the upper-left corner of the bounding rectangle of the pie shape. 
Width The width of the bounding rectangle of the pie shape. 

Profile 

Height The height of the bounding rectangle of the pie shape. 
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6.  You can click the following icons in the Draw toolbar to modify the properties of the pie shape 

Click Icon To 

 
Select a color for the outline. 

 
Select a color for painting the white part of the fill pattern. 

 
Select a pattern for the fill pattern. 

 
Select a color for painting the black part of the fill pattern. 
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4.1.9. Drawing Polygons 

1.  In the Draw menu or Draw toolbar, click Polygon to draw a polygon. 

2.  Move the cursor onto the screen where you want to draw a polygon and click the position where you want the first 
vertex of the polygon to be at. 

3.  Continue clicking on the screen to place as many points needed for vertices in the polygon. 

4.  Right-click to place the last vertex for the polygon and complete the polygon. 

5.  Drag one handle of the polygon at a time to resize the polygon.  

6.  Drag one black handle of the polygon at a time to adjust the vertex positions of the polygon.  

 

The picture on the left shows the handles of a polygon. The blue 
handles are for resizing the polygon. The black handles are for moving 
the vertices of the polygon.  

Position the mouse pointer over one of the handles. When the cursor 
changes to  or  or  or , drag the handle until the polygon is 
the shape and size you want.  
 

7.  Right-click anywhere on the polygon and use the Insert Point command on the object pop-up menu to insert a new 
point for the polygon. Or right-click the existing point of the polygon and use the Delete Point command on the 
object pop-up menu to delete the point. 

Pop-up menu Description 

Insert Point 

Add a point at the specified position. 

   
 

Delete Point 

Delete a selected point. 
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8. Double-click the polygon to bring up the Polygon dialog box to modify the settings of the polygon.  

 

 

The following table describes each property in the Polygon dialog box. 

Property Description 
Static Check this option if the color of the polygon will not be changed. 

Controlled By Bit Check this option if the color of the polygon will be controlled by the specified 
bit. 

Blink Check this option so the polygon will blink. You have to choose the blink effects 
that change the color of the polygon from its On state Outlined and Solid option 
settings to Off state Outlined and Solid option settings.  

Blink(Enabled by 
Bit) 

Check this option if you want to enable the polygon blinking by the specified bit.

Color 
Control 

Control Bit 
Specifies the bit that controls the color or enables the blinking.  

Click  to enter the bit address. Click  to enter the bit tag. 
State Select the state that you want to view or define the colors for. 

Outlined Check this option if you want the polygon to be outlined. 
Thickness Specifies the thickness of the outline. 

Outline 

Color Specifies the outline color for the selected state. 
Continued  
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Property Description 

Solid Check this option if you want the polygon to be solid. A solid polygon is filled with 
the specified pattern and colors. 

Pattern Specifies the fill pattern for the selected state. 

FG Color Specifies the color for the selected state that will be used for painting the black 
part of the fill pattern. 

Solid 

BG Color Specifies the color for the selected state that will be used for painting the white 
part of the fill pattern. 

Left The X coordinate of the upper-left corner of the bounding rectangle of the 
polygon. 

Top The Y coordinate of the upper-left corner of the bounding rectangle of the 
polygon. 

Width The width of the bounding rectangle of the polygon. 

Profile 

Height The height of the bounding rectangle of the polygon. 
Visibility 
Controlled By 
Bit 

Check this option if the polygon will be shown or hidden by the specified bit. 

Control Bit 
Specifies the bit that shows or hides the polygon.  

Click  to enter the bit address. Click  to enter the bit tag. 

Visibility 
Control 

Visible State Specifies the state (On or Off) that makes the polygon visible. 
 

9.  You can click the following icons in the Draw toolbar to modify the properties of the polygon.  

Click Icon To 

 
Select a line style for the border. 

 
Select a color for the border. 

 
Select a color for painting the white part of the fill pattern. 

 
Select a pattern for the fill pattern. 

 
Select a color for painting the black part of the fill pattern. 
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4.1.10. Drawing Text Objects 

1.  In the Draw menu or Draw toolbar, click Text . 

2.  Move the cursor onto the screen where you want to draw a text object. A text object with default settings will display 
and move along with the cursor. 

3.  Click the desired position on the screen to place the text object. The upper-left corner of the bounding box of the text 
object will be at the clicked position. 

4.  Double-click the text object to bring up the Text Object dialog box and then modify the settings of the text object. 
This dialog box contains the following three pages: 

■   General 
Described in Section 4.1.10.1. 

■   Shape 
Described in Section 4.3.4 

■   Visibility 
Described in Section 4.4.6.  

 

Note 1: You can use the Text toolbar to modify the properties of the text object's text instantly. 

Note 2: You can use the Draw toolbar to modify the properties of the text object's shape instantly. 

Tip: By default, the Auto Text Resizing on the Edit menu is checked and the related icon on the Edit toolbar is sunken. If 
you don’t want to resize the text when resizing the object, you need to uncheck the Auto Text Resizing command 

on the Edit menu or click the sunken icon  on the Edit toolbar to make the font size fixed.  
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4.1.10.1. General Settings 

This section describes how to define the general settings for text objects. 

 

 

 

 

 

 

Click to change text 
table. You can select 
the text or edit the text 
in the selected table. 

Select a text from the 
dropdown text table.  

Click to select a text 
from the text database 
of the current selected 
language. 

In this edit box, you can view 
and edit the current text of the 
current selected language.  

 

 
The above is an example of the General page of the Text Object dialog box. 
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The following table describes each property in the General page. 

Property Description 
Language The language that you are setting the text for. 
Shape Check this option if you want the text object to have a frame as its background. The Shape 

page appears in the dialog box when the option is selected. 
Use the text of the first 
language for all other 
languages 

Check this item so the text object always shows the text of the first language regardless of 
what the current language is. 

Font The font of the current text. You can use the drop-down list to select a font, or click  to 
bring up the Font Templates dialog box and select a font for the current text. You can 
change the font templates before selecting a font in that dialog box. 

<Edit Box> / 
<Combo Box> The current text of the currently selected language.  

Text 

 /  Click  to view and edit the text for the selected language in this edit box, or click  to 
select a text from dropdown text table that lists all the texts from Text Database. You can 
change the text database before selecting a text.  

Color The color of the text. To specify the color, click the corresponding Color icon and select a 
color from the Color palette. 

Transparent Check this item to make the background of the text transparent. 
BG Color Specifies the background color of the text. This field is available when Transparent is not 

selected.  
Direction Select one of the following directions to arrange the characters of the text. 

Direction From left to 
right 

From right to 
left 

From top to 
bottom 

From bottom 
to top 

Input text: 
An 
example 

 

  
 

Position 

 

The position of the text body. 

 
The alignment of the text. 

Border Spacing The margin (in pixels) to the border of the object’s shape for the text body. 
Line Spacing The distance (in pixels) between two adjacent lines of the text. 
Character Spacing The distance (in pixels) between two adjacent characters of the text. 
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4.1.11. Drawing Picture Objects 

1.  In the Draw menu or Draw toolbar, click Picture . 

2.  Move the cursor onto the screen where you want to draw a picture object. A picture object with default settings will 
display and move along with the cursor. 

3.  Click the desired position on the screen to place the picture object. The upper-left corner of the bounding box of the 
picture object will be at the clicked position. 

4.  Double-click the picture object to bring up the Picture Object dialog box. Select a picture and define the settings for 
the picture object in the dialog box. Note that you can use the Picture toolbar to modify the properties of the picture 
object instantly. The following is an example of the Picture Object dialog box. 

 

The following table describes each property in the Picture Object dialog box. 

Property Description 

Name 

The name of the picture that the object displays. You can use the drop-down list to select a 
picture from the picture database. 

Click  to select a picture from a file. After the selection, the software imports the picture 
of the selected file and saves the picture in the picture database. 

Click  to bring up the Select/Import from Library dialog box. Select a picture from a 
picture library file. After the selection, the software imports the selected picture from the 
selected library and saves the picture in the picture database. 

View Shows the processed result of the selected picture according to the current settings. 
Continued 

CHAPTER 4   DESIGNING SCREENS  



4 4  
 

 

 
4-25 

 
Property Description 

Fit to Object Check this item so the picture can change its size automatically to fit inside the 
object. 

Transparent 
Check this item to make parts of the picture transparent. The transparent parts 
are pixels whose colors are identical to the specified transparent color. This 
item is available when the picture is not a black and white picture. 

Transparent Color The transparent color. This item is available when the picture is not a black 
and white picture. 

FG Color The color to paint the black part of a black and white picture. This item is 
available when the picture is a black and white picture. 

BG Color The color to paint the white part of a black and white picture. This item is 
available when the picture is a black and white picture. 

Flip/Rotate Specifies the method to flip or rotate the picture before drawing it. There are 8 
options: 

Method Description 
0° Do nothing 
90° Rotates the picture clockwise by 90 degrees 
180° Rotates the picture clockwise by 180 degrees 
270° Rotates the picture clockwise by 270 degrees 
X Flips the picture over the X axis 
90° & X Rotates the picture clockwise by 90 degree and flips it over the 

X axis 
Y Flips the picture over Y axis 
90° & Y Rotates the picture clockwise by 90 degree and flips it over the 

Y axis  
Tone Check this item to tone the picture. 
Toning Color The color to tone the picture. 

Visibility 
Controlled By Bit 

Check this option if the picture will be shown or hidden by the specified bit. 

Control Bit Specifies the bit that shows or hides the picture object.  

Click  to enter the bit address. Click  to enter the bit tag. 

Visibility 
Control 

Visible State Specifies the state (On or Off) that makes the picture visible. 
Left The X coordinate of the upper-left corner of the object. 
Top The Y coordinate of the upper-left corner of the object. 
Width The width of the object. 
Height The height of the object. 

Profile 

Redraw Click this button to redraw the object on the screen with the current settings. 
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4.1.12. Drawing Scales 

1.  In the Draw menu or Draw toolbar, click Scale . 

2.  Move the cursor onto the screen where you want to draw a scale. A scale with default settings will display and move 
along with the cursor. 

3.  Click the desired position on the screen to place the scale. The upper-left corner of the bounding box of the scale 
will be at the clicked position. 

4.  Double-click the scale to bring up the Scale dialog box and then define the settings for the scale. The following is an 
example of the Scale dialog box. The corresponding scale is shown to the right of the dialog box. 
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The following table describes each property in the Scale dialog box. 

Property Description 
Direction and Position Select the direction and the position of the scale.  

Direction Horizontal Vertical 
Position Top Bottom Left Right 
Example 

 

 

Dynamic 
Range 

Check this item if you want the numbers of the scale ticks and the range of the scale marks 
to be dynamic, i.e. to be controlled by the specified variable. 

Dynamic 
Range 

Parameter 
Block 

Specifies the variable that controls the numbers of the scale ticks and the range of the 
scale marks. The variable is an array of four double-words (8 words). The following table 
describes the data members of the array. 
Word # Data Type Description 
0, 1 32-bit unsigned integer The number of major ticks. The allowable range of 

this number is between 2 and 101. 
2, 3 32-bit unsigned integer The number of divisions between two adjacent 

major ticks. The allowable range of this number is 
between 1 and 100. 

4, 5 32-bit signed integer The minimum of the scale marks. 
6, 7 32-bit signed integer The maximum of the scale marks. 

 
Example 
Assume a scale’s dynamic range control block is $U100. The following macro commands 
makes the scale look like this:  
 

 
 

Color The color of the scale. To specify the color, click the corresponding Color icon and select a 
color from the Color palette. 

Number of Major Ticks The number of major ticks. The minimum you can specify is two. 
Number of Sub 
Divisions 

The number of divisions between two adjacent major ticks. The minimum you can specify 
is one.  

Minor Tick Length The length of minor ticks.  
Axis Check this item if you want the scale to have an axis. 

Marks Check this option if you want the scale to have marks. 
Font The font of the marks. 
Minimum The minimum of the marks. It is a 32-bit integer. 
Maximum The maximum of the marks. It is a 32-bit integer. 
Total Digits The total digits to be displayed for the marks. 
Fractional 
Digits 

The number of fractional digits for the marks. For example, when the Maximum is 5000, the 
Total Digits is 4, and the Fractional Digits is 2, the mark for the Maximum will be 50.00. 

Marks 

Reverse 
Order 

Check this option if you want the marks of the scale to show in reverse order. In normal 
order, the maximal mark is at the right end or top end of the scale. In reverse order, the 
maximal mark is at the left end or bottom end of the scale. 

$U100 = 3 (UD) // The number of major ticks. 
$U102 = 5 (UD) // The number of sub-divisions. 
$U104 = 0 (SD) // The minimum of the scale marks. 
$U106 = 100 (SD) // The maximum of the scale marks. 
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4.1.13. Drawing Tables 

1.  In the Draw menu or Draw toolbar, click Table . 

2.  Move the cursor onto the screen where you want to draw a table. A table with default settings will display and move 
along with the cursor. 

3.  Click the desired position on the screen to place the table. The upper-left corner of the table will be at the clicked 
position. 

4. Use drag-and-drop editing to move an existing object into an empty cell of the table. If the object is allowed to be 
placed in the cell, a message box will pop-up to confirm the operation. The following is an example of object 
insertion with the confirmation dialog box. 

 

 If you click Yes to insert the object to the table, 
the object will be part of the table. Any 
modifications such as moving the table, resizing 
the table, deleting the table… will be applied to 
the objects of the table at the same time.  

 
 If you click No to cancel the operation, the 
object will move to the specified position and 
float over the table.

Note: Only 23 types of objects can be placed in the cells of the table. The supported objects are Picture, Dot, Text, 
Bit Button, Toggle Switch, Word Button, Multistate Switch, Screen Button, Function Button, Keypad Button, Numeric 
Display, Numeric Entry, ASCII String Display, ASCII String Entry, Bit Lamp, Multistate Lamp, Time Display, Date 
Display, Day-of-Week Display, Message Display, Bar Graph, Picture Display, GIF Display, and Advanced Numeric 
Display. 

5.  Click the cell inside the table. If the cell contains the object, there will be the  icon on the upper-left corner of the 
cell. The following is an example showing you how to edit the object in the table. 

 

 Left-click the icon 
and hold down the 
button. When the 
cursor changes to , 
move the object out of 
the table.  
 

 Double click the icon 
to bring up the 
properties dialog box 
of the corresponding 
object and then define 
the settings of object 
for the selected cell. 

This is an empty 
cell where you 
can place an 
object. 
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6. Position the mouse point over one of the grid lines. When the cursor changes to  or , drag the line until the 
column is the width and the row is the height you want.  

 

Drag the line to adjust the 
width of the column. 

Drag the line to adjust the 
height of the row. 

Note: You can adjust the width of the column when the Distribute Columns Evenly is not selected in the general 
page of the Table dialog box. And you can adjust the height of the row when the Distribute Rows Evenly is not 
selected in the general page of the Table dialog box. 

7. Double-click anywhere inside the table, other than the  icon, to bring up the Table dialog box and then define the 
settings for the table. This dialog box contains the following two pages: 

  
■   General 

Described in Section 4.1.13.1. 
■   Cell 

Described in Section 4.1.13.2. 
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4.1.13.1. General Settings 
This section describes how to define the general settings for the table objects. The following is an example of the General 
page of the Table Object dialog box. 

 
The following table describes each property in the General page of the Table dialog box. 

Property Description 
ID The object’s identifier is generated when the object is created and is unchangeable. 

The identifier is unique within the screen where the object is located. The format of the 
IDs for the tables is TBLnnnn. 

Note You can type a note for the object. 
Shape settings For details about the following properties, see Section 4.3.4 Setting up the Shape of an 

Object. , Border Color, BG Color 
Number of rows Specifies the number of rows in the table. 
Number of columns Specifies the number of columns in the table. 
Distribute rows 
evenly 

Check this option if you want the rows of the table to be always distributed evenly. 
Uncheck this option if you want to adjust the heights of the rows. 

Distribute columns 
evenly 

Check this option if you want the columns of the table to be always distributed evenly. 
Uncheck this option if you want to adjust the widths of the columns. 

Cell 

Drag and drop Check this option so you can drag and drop an object into a cell of the table. Note that 
not all kinds of objects can be placed in the cells of the table. 

Vertical Check this option if you want the table to have vertical grid lines. 
Horizontal Check this option if you want the table to have horizontal grid lines. 
Style Specifies the style for the grid lines. 

Grid 

Color Specifies the color for the grid lines.  
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4.1.13.2. Cell Settings 
The following is an example of the Cell page of the Table Object dialog box and the Select Object Dialog box when the 
Insert Button is clicked. 

                          

Click the button to bring up 
the Select Object dialog. 

The following table describes each property in the Cell page of the Table dialog box. To make the buttons available, you 
need to select a row. To select a row, left-click the (Row, Column) column. 

Property Description 
(Row,Column) The location of the cell. 
Object The type of the specified object. If the field is empty, the cell has no object inserted and it is called 

empty cell. 

 
Click the button to bring up the properties dialog box of the specified object and define the settings 
of the object for the selected cell. The button is available when the Object field is not empty. 

Margin The distance in pixels between the object boundary and the cell border. Select a number between 0 
and 10. 

Delete Click the button to clear the contents of the selected cell. The button is available when the selected 
cell is not empty. 

Insert Click the button to bring up the Select Object dialog box shown above. Select an object type listed 
in the dialog to create a new object for the selected cell. The button is available when the selected 
cell is empty. 
 
Note: The table won’t allow the insertion of the type of object which is not listed in the dialog. 

Move Up Click the button to move the selected cell before the previous cell. It will not be available when 
multiple rows are selected, no row is selected, or the first row is selected. 

Move Down Click the button to move the selected cell after the next cell. It will not be available when multiple 
rows are selected, no row is selected, or the last row is selected. 
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4.2. Editing Objects 

In this section you will learn how to select the objects first and then move around, copy, or edit the selections without 
affecting the rest of the screen. 

4.2.1. Selecting and De-selecting Objects 
■ Selecting Objects 
To select an object, move the mouse to the object you want to select and then click the left button.  
To add an object to the selection, use Shift + Click.  
To select all objects of the active screen, use Ctrl + A, or use the Select All command on the Edit menu.  
 
■ Selecting Objects by a Rectangular Area 
Left-click on the blank area of the screen, and hold the button to begin your selection. Where you click will become one of 
the corners of the rectangular selection area. Then drag the mouse diagonally. Release the mouse button when you reach 
the position that you want the opposite corner of the rectangular area to be.  
 
Each of the selected objects will have blue square-shaped tabs around it. The object with solid tabs is the reference object. 
 
■ De-selecting Objects 
To de-select objects, either click the blank area of the screen, or make a new selection.  

4.2.2. Basic Operations with the Selected Area 
■ Moving Objects 

Left-click anywhere inside the selected object and hold down the button. When the cursor turns changes to , drag the 
mouse to move the selection to another area of the screen. The selection will "float" over the rest of the screen, allowing 
you to position it wherever you like. Release the mouse button to "let go" of the selection.  
 
■ Grouping or Ungrouping Objects 

To group the selection, click  on the edit toolbar, or use the Group command on the Edit menu or on the object pop-up 
menu. After you have grouped a selection that includes at least two objects, you can copy, move or resize all objects in a 
group as a single unit. You can select an object within the group and change its properties without ungrouping. You can 
also save the group to the object library and use this object group in an animated graphic. 

To ungroup the selected group, click  on the edit toolbar, or use the Ungroup command on the Edit menu or on the 
object pop-up menu. After ungrouping the objects, the objects within the group will be restored to the single ones. 

 

■ Resizing Objects 
The square-shaped tabs around your object can be re-sized. You can resize by clicking on the square-shaped tabs located 
at the corners and the middle sections of the bound rectangle area and holding the mouse button down. When the cursor 
changes to  or  or  or , drag the mouse to change the size of the selection. Release the mouse button when 
the selection is the size you like. You can make it bigger or smaller, and achieve a distorted effect by "squashing" or 
"stretching" the selection to make it either wider/narrower or taller/shorter than its original proportions. 
Tip: You can’t resize more than one object at a time unless you group multiple objects before resizing. 
 
■ Auto Text Resizing 

To automatically scale the text of the object when resizing the object, click  on the edit toolbar if it is raised, or use the 
Auto Text Resizing command on the Edit menu.  
Tip: The Auto Text Resizing command is checked and the icon is sunken by default. If you don’t want to resize the text 

when resizing the object, you need to uncheck the Auto Text Resizing command or click the sunken icon to make the 
font size fixed. 
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■ Pinning or Unpinning Objects 

To pin the selection so that it cannot move, click  on the edit toolbar, or use the Pin command on the Edit menu or on 
the object pop-up menu.  

To unpin the selection so that it can move again, click  on the edit toolbar, or use the Unpin command on the Edit 
menu or on the object pop-up menu. 
Tip: Pinned objects can still be resized. 
 
■ Copying or Cutting and Pasting Objects 

To copy a selection from the current screen and place it on the Windows™ clipboard, press Ctrl+C, or click  on the 
standard toolbar, or use the Copy command on the Edit menu or on the object pop-up menu.  

To cut a selection from the screen, press Ctrl+X, or click  on the standard toolbar, or use the Cut command on the 
Edit menu or on the object pop-up menu.  

After Copying or Cutting, you can paste the selection by pressing Ctrl+V, or click  on the standard toolbar, or use the 
Paste command on the Edit menu or on the object pop-up menu.  
 

 

To copy and paste the selection by mouse, press and hold down the Ctrl key,
and then left-click the selection and hold down the button. When the cursor
changes to , drag the mouse to copy the selection to another area of the
screen. The picture on the right is an example. 

Tip: Cut and Paste are good for moving objects around within the screen or to another screen. 
Copy and Paste are good for duplicating objects from the current screen to other screens.  
By pasting multiple times on the current screen, you can achieve a cascading effect.  
By pasting once to a different screen, the position of the pasted object will be the same as the copied object from the 
original screen. 

 

■ Deleting Objects 
To delete a selection, press Del, or use the Delete command on the Edit menu, or on the object pop-up menu. When you 
use Delete, whatever is in the selection will be deleted. 
 
■ Undo 
To reverse the last action, press Ctrl+Z, or use the Undo command on the Edit menu. 
 
■ Redo 
To reapply the actions that were previously canceled by the Undo command, press Ctrl+Z, or use the Redo command on 
the Edit menu. 
 
■ Keyboard Shortcuts  

Shortcut Operation Shortcut Operation Shortcut Operation 
【Ctrl+N】 New Project 【Ctrl+X】 Cut 【Ctrl+D】 Duplicate 

【Ctrl+O】 Open Project 【Ctrl+C】 Copy 【Ctrl+F】 Find 

【Ctrl+S】 Save 【Ctrl+V】 Paste 【Ctrl+R】 Replace 

【Ctrl+Z】 Undo 【Ctrl+Click+move】 Copy & Paste 【Ctrl+A】 Select All 

【Ctrl+Y】 Redo 【Del】 Delete 【Shift+Click】 Multiple Select 

    【Ctrl+Click】 Reference Object Select 
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4.2.3. Duplicating Objects 
To duplicate the selected object, use the Duplicate… command on the Edit menu or on the object pop-up menu. After the 
duplicate command is executed, the following dialog will pop-up and allow you to set how to duplicate objects.  
 

 

 
 

Preview 
addresses 

Click View > Address > Monitor on the 
menu to show the monitor address on the 
upper-left corner of the object.  

The following table describes each property in the Duplicate dialog. 

Property Description 
Columns The total number of columns. Number 

of Copies Rows The total number of rows. 
Vertical The distance (in pixels) between two adjacent objects in the vertical direction. Spacing 

in Pixels Horizontal The distance (in pixels) between two adjacent objects in the horizontal direction. 
Increase Address Check this item so the address of each duplicate will be increased to a specified increment 

over the previous object. 
Increment The increase amount. 

 
From top to bottom, place the duplicates row by row. In the same row, place the duplicate to 
the right of the previous object. 

 
From top to bottom, place the duplicates row by row. In the same row, place the duplicate to 
the left of the previous object. 

 
From bottom to top, place the duplicates row by row. In the same row, place the duplicate to 
the right of the previous object. 

 
From bottom to top, place the duplicates row by row. In the same row, place the duplicate to 
the left of the previous object. 

 
From left to right, place the duplicates column by column. In the same column, place the 
duplicate below the previous object. 

 
From right to left, place the duplicates column by column. In the same column, place the 
duplicate below the previous object. 

 
From left to right, place the duplicates column by column. In the same column, place the 
duplicate above the previous object. 

Copy 
Direction 

 
From right to left, place the duplicates column by column. In the same column, place the 
duplicate above the previous object. 
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4.2.4. Aligning Objects 
To arrange the selected objects on a screen, you need to select a reference object from within the selection and then press 
the icon on the toolbar or click the menu item listed as below. To do a multiple selection, use Shift + Click. To select a 
reference object from the selection, use Ctrl + Click. 

Use the Align commands on the Edit menu to arrange objects/drawings on a screen. Select an object or drawing by 
single-clicking on it, then hold down the Shift key while clicking on the other objects or drawings to be aligned with it. When 
all of the objects or drawings to be aligned are selected, choose one of the commands in the Align submenu or directly 
click a specified icon in the Edit Toolbar. 

Icon Menu Item Description 

 Left 
Align the left sides of selected objects to the left side of the reference object. All the 
objects move horizontally so their left sides are in line with the left side of the 
reference object. 

 
Vertical 
Center 

Align the vertical centers of selected objects to the vertical center of the reference 
object. All the objects move horizontally so their vertical centers are in line with the 
vertical center of the reference object. 

 Right 
Align the right sides of selected objects to the right side of the reference object. All the 
objects move horizontally so their right sides are in line with the right side of the 
reference object. 

 Top Align the tops of the selected objects to the top of the reference object. All the objects 
move vertically so their tops are in line with the top of the reference object. 

 
Horizontal 
Center 

Align the horizontal centers of selected objects to the horizontal center of the 
reference object. All the objects move vertically so their horizontal centers are in line 
with the horizontal center of the reference object. 

 Bottom 
Align the bottoms of selected objects to the bottom of the reference object. All the 
objects move vertically so their bottoms are in line with the bottom of the reference 
object. 

 

Align 

To Grid Select or deselect the option of aligning objects to grid points. 

 Left 

Nudge the selection left. When the Snap to Grid option is not selected, all objects of 
the selection move one pixel left. When the Snap to Grid option is selected, each 
object of the selection moves left to where its upper-left corner aligns to the nearest 
grid point. 

 Right 

Nudge the selection right. When the Snap to Grid option is not selected, all objects of 
the selection move one pixel right. When the Snap to Grid option is selected, each 
object of the selection moves right to where its upper-left corner aligns to the nearest 
grid point. 

 Up 

Nudge the selection up. When the Snap to Grid option is not selected, all objects of 
the selection move one pixel up. When the Snap to Grid option is selected, each 
object of the selection moves up to where its upper-left corner aligns to the nearest 
grid point. 

 

Nudge 

Down 

Nudge the selection down. When the Snap to Grid option is not selected, all objects of 
the selection move one pixel down. When the Snap to Grid option is selected, each 
object of the selection moves down to where its upper-left corner aligns to the nearest 
grid point. 
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4.2.5. Making Objects Same Size 
Make objects in the selection the same size as the reference object by first selecting the objects using Ctrl + Click, press 
the icon on the toolbar or click the menu item listed below.  

Icon Menu Item Description 

 Width Make the selected objects have the same width as the reference object. 

 Height Make the selected objects have the same height as the reference object. 

 

Make 
Same 
Size 

Both Make the selected objects have the same width and height as the reference object. 
 

 

4.2.6. Arranging the Order of Objects 
Icon Menu Item Description 

 Bring to Top Bring the selection to the top. 

 Bring Forward Bring the selected object one layer up. 

 Send Backward Send the selected object one layer down. 

 

Layer 

Send to Bottom Send the selection to the bottom. 

 Set Order Start the order setting process for the objects of the active screen. For details, 
please see Section 4.2.6.1 Changing the Order of Objects 

 

4.2.6.1. Changing the Order of Objects 
The object order in the software is the order in which the selection cursor moves the input focus from one object to the 
next within a screen. Usually the order proceeds from left to right and from top to bottom in a screen. In the model with 
programmable keys such as 037-LSK, the Data Entry Object receives input focus in the specified order by clicking 
direction keys. In a touch panel, you can use the function button to select a data entry object with the order number 
previous or next to the current selection. 
 
The object order is also the display order. If the screen contains overlapping objects, changing the order will change the 
display sequence of the objects. The objects that come later in the order are always displayed on top of any overlapping 
objects that precede them in the order. 
 
■ Viewing order 
To view the current order of all objects in the screen, click Set Order on the Edit menu. 
 
■ Changing order 
To change the order for all objects in the screen 
1) On the Edit menu, click Set Order 

A Number in the upper-left corner of each object shows its place in the current order 
2) Set the order by clicking each object in the order that you want the objects to be displayed. The ordering number 

starts from 1. 
3) Click the blank field on the screen to exit Set Order mode 
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The following is an example of the object ordering. 

   
 
If the screen is running on 037-LSK, click the down or right direction key to move the selection in 2-4-6-8-10-12-14-16-18 

-20-29 sequence. If the screen is running on the touch panel, click the function button  to move the selection in the 
same sequence. The text objects with 1,3,5…order number are not data entry object, so they won’t receive the selection 
and are not listed in the sequence. 
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4.3. Designing Object Appearance 

There are four common components of object appearance. They are described in the following table: 

Appearance Component Description 
Shape The shape of an object can either be a graphical shape or a picture shape. 

The following are examples of graphical shapes 

 
The following are examples of picture shapes. 

 
The software provides many graphical shapes for you to choose from. For details, see 
Section 4.3.3 Selecting a Graphical Shape. The color or the pattern of a graphical shape is 
dependent on the state of the associated object. You need to specify the color or pattern 
settings of a graphical shape for each state of the associated object. For details, see 
Section 4.3.1 Selecting a Color and Section 4.3.2 Selecting a Pattern. 
 
If you want an object to have a picture shape, check the item Picture Shape in the General 
Page of the object’s property dialog box. You can select a picture from the picture 
database or import a picture from a library file for the shape of an object. Any picture with 
the format of BMP, JPG, or WMF can be a picture shape. When a picture is used as a 
shape, the shape is state independent, i.e. the same look appears for all (object) states. If 
you want a picture shape to display the object state and/or show the touch action, you 
need to select a picture group as the shape. For details of picture groups, please see 
Section 2.2.3.2 Picture Groups 
 
To know how to set a shape, see Section 4.3.4 Setting up the Shape of an Object. 

Inner Label An inner label is a label inside the associated object. It has the same number of states as 
the associated object. You need to specify the text settings and the picture settings of an 
inner label for each (object) state. Inner labels are language dependent. You need to 
specify the text of an inner label for each language as well. Note that not all objects can 
have inner labels and some objects can have just text or a picture as their inner label. 
To know how to set an inner label, see Section 4.3.5 Label Settings. 

VFTA (Visual Feedback for 
Touch Action) 

A button or switch can give the operator one of the following visual feedbacks when it is 
touched: 

Visual Feedback Description 
Sunken Shifts the inner label to the lower-right corner by one or two pixels.
Back Fills the area inside the border of the shape with the shape’s FG 

Color. 
Outline Outlines the object with the shape’s FG Color.  

External Label An external label is a label outside of but still attached to the associated object. Unlike 
inner labels, external labels are state independent. They have the same look for all 
(object) states. However, external labels are language dependent. You need to set the 
text of an external label for each language. External labels are touch insensitive. Touching 
an external label will not activate the associated object. Note that not all objects can have 
an external label. 
To know how to set an external label, see Section 4.3.8 External Label Settings. 
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The following table shows the common appearance components that each object type can have: 

Shape Inner Label 
Object Types Graphical

Shape 
Picture 
Shape Text Picture 

VFTA External 
Label 

Bit Button, Toggle Switch, Screen Button, Word 
Button, Multi-state Switch, Radio Button Group ● ● ● ● ● ● 

Function Button, Keypad Button, Page Selector ● ● ● ● ●  
Step Button ●  ● ● ● ● 
Bit Lamp, Multi-state Lamp,  ● ● ● ●  ● 
Message Display ●  ●   ● 
Picture Display ●   ●  ● 
Day-of-week Display ●  ●    
Meter ● ●     
Slide Switch, Numeric Entry, Numeric Display, 
Advanced Numeric Display, ASCII Character 
Entry, ASCII Character Display, Bar Graph 

●     ● 

Time Display, Date Display, Pie Graph, Line Chart, 
Scatter Chart, Alarm Display, Historic Data 
Display, Historic Trend Graph, Single Record Line 
Chart, Operation Log Display, Recipe Selector, 
Recipe Table, Sub-link Table, Static Text, Table 

●      

Animated Graphic    ●   
 
The orders of drawing the common appearance components are shown in the following table with examples: 
Step Draw Example 1 Example 2 Description 

  1 Shape 
A picture group that supports 
the pressed look 

A graphical shape named 
SW_0023 

Described in Section 4.3.4 

2 Picture of Inner 
label  

(None) Described in Section 4.3.5.2 

3 Text of inner 
label   Described in Section 4.3.5.1 

4 VFTA (None) Back (FG Color is )  

5 External label (None) 
 

Described in Section 4.3.8 

Final Appearance 
(When untouched)   

 

Final Appearance 
(When touched)   
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4.3.1. Selecting a Color 
■ Color Icons 
In a dialog box, a color icon is associated with a property that requires a color. It shows the color of the current selection 
and you can click it to bring up the Color palette. With the Color palette, you can select a color for the associated property. 
The following is a Color icon showing that the current selection is yellow. 

 
 
■ Color Palette 
With the Color palette, you can: 1) Select a color from a set of predefined colors, 2) Customize a set of user colors, and 3) 
Select a color from a set of user colors. 
 
Usually, you click a Color icon to bring up the Color palette. The following shows the pages of the Color palette. 

       
On page 1, the yellow block is outlined to indicate that it is the current selection. To select a color, click on that color block. 
To select a page, click on that page’s number tab. To cancel the operation click on any position other than the color blocks 
and the number tabs. Page 1, 2, and 3 contain the predefined colors. Page 4 contains the user colors. To customize user 
colors, click  to bring up the Define Custom Color dialog box as shown below. 
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4.3.2. Selecting a Pattern 
■ Pattern Icons 
In a dialog box, a Pattern icon is associated with a property that requires a pattern. It shows the pattern of the current 
selection and you can click it to bring up the Pattern palette. With the Pattern palette, you can select a pattern for the 
associated property. The following is a Pattern icon showing that the current selection is the “big dashes”. 

 
 
■ Pattern Palette 
With the Pattern palette, you can select a pattern from a set of predefined patterns. Usually, you click a Pattern icon to 
bring up the Pattern palette as shown below. 

 
The “big dashes” block is outlined to indicate that it is the current selection. To select a pattern, click on that pattern block. 
To cancel the operation, click on any position other than the pattern blocks. 
 

4.3.3. Selecting a Graphical Shape 
■ Shape Buttons 

In an object’s property dialog box, you can click the shape button  to bring up the Shape palette. With the Shape 
palette, you can select a graphical shape as the shape of the associated object. 
 
■ Shape Palette 

With the Shape palette, you can select a graphical shape for an object. Usually, you click  to bring up the Shape 
palette. The Shape palette contains several pages of graphical shapes. To select a graphical shape, click on that graphical 
shape. To select a page, click on that page’s number tab. To cancel the operation, click the close button  to close the 
Shape palette. 
 
There are four sets of graphical shapes available for your applications. Each of them is suitable for certain kinds of objects. 
The Shape palette shows the set that is suitable for the type of object concerned. The four sets of shapes are shown 
below. 
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Graphical shapes for buttons and switches 

      

    

Graphical shapes for data entry objects 
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Graphical shapes for data display objects 

      

Graphical shapes for lamps 
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4.3.4. Setting up the Shape of an Object 
This section describes how to set the shape of an object. 
In order to give the operator visual feedback for the touch action, most of the graphical shapes designed for touch operable 
objects can change their look when touched. The edge or border can look pressed or the outline can be shown with a 
different color. 
 
The following examples are the shape settings of a bit button: 

Example 1 Example 2 
The graphical shape SW_0031 is selected. The graphical shape is a picture. 

 

 
The following table describes each property that may be required for the settings of an object’s shape. 

Property Description 
Picture Shape Check this option if you want the object to have a picture shape instead of a graphical shape. This 

option is available when the object can have a picture shape. 

 
Click this button to specify the shape of the object. When Picture Shape is checked, the 
Select/Import from Library dialog box will display. Otherwise, the Shape palette will display. 

VFTA  The type of VFTA (Visual Feedback for Touch Action). 
Test VFTA Click this button to view the selected VFTA. 
Border Color The border color of the graphical shape. Click the corresponding Color icon to specify the color. 
Pattern The pattern that is used to fill the area inside the border of the graphical shape for the current 

(object) state. To specify the pattern, click the corresponding Pattern icon and select a pattern from 
the Pattern palette. This item is available when the area inside the graphical shape needs be 
painted. 

FG Color The color that is used to paint the black part of the pattern for the current (object) state. When the 
solid white pattern is selected, this color is not used. When a picture shape is used, this color is used 
for the outline mode with VFTA. 
Example 1 Example 2 

  
To specify the color, click the corresponding Color icon and select a color from the Color palette. 
This item is available when the area inside the graphical shape needs be painted. 

BG Color The color that is used to paint the white part of the pattern for the current object state. To specify the 
color, click the corresponding Color icon and select a color from the Color palette. This item is 
available when the area inside the graphical shape needs be painted. 
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4.3.5. Label Settings 
This section describes how to set up the inner label for the following types of objects: 

Bit Button, Toggle Switch, Screen Button, Function Button, Word Button, Keypad Button, and Bit Lamp. 
 

The property sheets of the above mentioned objects provide you with the Label page to set up the inner label. If an object 
only has one state, the Label page has the Text sub-page and the Picture sub-page for you to set up the text and the 
picture of the inner label respectively. If an object has two states, the Label page has the following four sub-pages: 

Sub-page For Setting 
OFF Text Text of state 0 (Off) 
OFF Picture Picture of state 0 (Off) 
ON Text Text of state 1 (On) 
ON Picture Picture of state 1 (On) 

 
You can use the Label page to set the inner label of an object that can have at most two states.  
The following is an example of the Label page. 
 

The following table describes only the properties in 
the Label page that are common to all its sub-pages. 
The properties of each of its sub-pages are described 
in the specific section about each sub-page. 

Property Description 

Language The language that you are setting 
the text for. 

Border Spacing
The margin (in pixels) to the 
border of the object’s shape for 
both the text body and picture. 

Use the text of 
the first 
language for all 
other 
languages 

Check this item so the inner label 
always shows the text of the first 
language regardless of what the 
current language is. 

Text tab Click this tab to bring up the Text 
sub-page. 

Picture tab Click this tab to bring up the 
Picture sub-page. 

OFF Text tab Click this tab to bring up the OFF 
Text sub-page. 

ON Text tab Click this tab to bring up the ON 
Text sub-page. 

OFF Picture 
tab 

Click this tab to bring up the OFF 
Picture sub-page. 

ON Picture tab Click this tab to bring up the ON 
Picture sub-page.  
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4.3.5.1. Text Sub-page Settings 
You can use the Text sub-page, OFF Text sub-page, and ON Text sub-page to set up the text of the inner label for each of 
the corresponding states, as well as the current language. The language being set is specified by the Language item in the 
Label page.  
 
The following are examples of the Text pages:  

Text sub-page ON Text sub-page 

 

The following table describes each property in the Text sub-page, OFF Text sub-page, and ON Text sub-page. 

Property Description 
Copy from Note Click this button to replace the current text by the text of Note in the General page. 
Copy to ON State Click this button to use the current text to replace the text of ON state. 
Copy to OFF 
State 

Click this button to use the current text to replace the text of OFF state. 

Font The font of the text. You can use the drop-down list to select a font.  

Click  to bring up the Font Templates dialog box and select a font for the text. You can 
change the font templates before selecting a font in that dialog box. 

Color The color of the text. To specify the color, click the corresponding Color icon and select a color 
from the Color palette. 

Blink Check this item so the text will blink. You have blink effects to choose from. Color switching 
changes the color of the text from its original color to the color of the background. Text On/Off 
displays and hides the text. 

Transparent Check this item to make the background of the characters transparent. 
BG Color The background color of the text. 

Continued
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Property Description 

Line Spacing The distance (in pixels) between two adjacent lines of the text. 
Character 
Spacing 

The distance (in pixels) between two adjacent characters of the text. 

 
The alignment of the text. 

Position 

 

The position of the text body. 

Shape BG Color The BG color of the object’s shape for the current state. 
Copy Attributes to 
ON State 

Click this button to use the current attributes to replace the text of ON state. 

Copy Attributes to 
OFF State 

Click this button to use the current attributes to replace the text of OFF state. 

 

4.3.5.2. Picture Sub-page Settings 
You can use the Picture sub-page, OFF Picture sub-page, and ON Picture sub-page to set up the picture of the inner label 
for the corresponding states.  
 
The following are examples of the Picture pages: 

Picture sub-page ON Picture sub-page. 
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The following table describes each property in the Picture sub-page, OFF Picture sub-page, and ON Picture sub-page. 

Property Description 
Name The name of the picture. You can use the drop-down list to select a picture from the picture database.

Click  to select a picture file. After the selection, the picture of the selected file is imported and 
saved in the picture database. 

Click  to bring up the Select/Import from Library dialog box. Select a picture from a picture library 
file. After the selection, the selected picture is imported and saved in the picture database. 

Copy to OFF 
State Click this button to use the current picture to replace the picture of OFF state. 

Copy to ON 
State Click this button to use the current picture to replace the picture of ON state. 

Transparent Check this item to make parts of the picture transparent. The transparent parts are pixels whose 
colors are the same as the specified transparent color. This item is available when the picture is not a 
black and white picture. 

T. Color The transparent color. 
FG Color The color to paint the black part of a black and white picture. This item is available when the picture is 

a black and white picture. 
BG Color The color to paint the white part of a black and white picture. This item is available when the picture is 

a black and white picture. 
Flip/Rotate Specifies the method to flip or rotate the picture before drawing it. There are 8 options: 

Method Description 
0° No rotation 
90° Rotates the picture clockwise by 90 degrees 
180° Rotates the picture clockwise by 180 degrees 
270° Rotates the picture clockwise by 270 degrees 
X Flips the picture over the X axis 
90° & X Rotates the picture clockwise by 90 degrees and flips it over the 

X Axis 
Y Flips the picture over the Y axis 
90° & Y Rotates the picture clockwise by 90 degrees and flips it over the 

Y Axis  

Tone Check this item to tone the picture. 
Toning Color The color to tone the picture. 
Fit to Object Check this item so the picture can change its size automatically to fit inside the border of the object’s 

shape. 
Position 

 

The position of the picture within the object. 

Shape BG 
Color The BG color of the object’s shape for the current state. 
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4.3.6. Text Settings 
This section describes how to set up the text of the inner label for the following types of objects: 

Multi-state Switch, Radio Button Group, Step Button, Page Selector, Multi-state Lamp, Message Display, and 
Day-of-week Display. 

 

The property sheets of the above mentioned objects provide you with the Text page to set up the text of the inner label. 
The following is an example of the Text page. 

 

The text of the current state and 
language. You can view and edit 
the current text here. 

You can view the texts and the picture names of all 
the states here. You can select a state from the list. 
The text of the selected state becomes the current 
text.

 
The following table describes each property in the Text page. 

Property Description 
Language The language that you are setting the text to. 
Border Spacing The margin (in pixels) of the border for the text body to the object’s shape. 
Use the text of the 
first language for all 
other languages 

Check this item so the inner label always shows the text of the first language regardless of 
what the current language is. 

<State list> Lists all states and the corresponding texts. To view and modify the state attribute and its text, 
click the row of that state. 

Move Up Click this button to move the current text (and picture) up the list, and thus the associated 
state number of the current text (and picture) is decreased by one. 

Move Down Click this button to move the current text (and picture) down the list, and thus the associated 
state number of the current text (and picture) is increased by one. 

Continued
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Property Description 

Copy to all states… Click this button to use the text of state 0 to replace the text of all other states. 
Copy from state 0… Click this button to use the text of state 0 to replace the current text. 
Font The font of the current text. You can use the drop-down list to select a font.  

Click  to bring up the Font Templates dialog box and select a font for the current text. 
You can change the font templates before selecting a font from the dialog box. 

Color The color of the current text. To specify the color, click the corresponding Color icon and 
select a color from the Color palette. 

Transparent Check this item to make the text’s background transparent. 
BG Color The background color of the text. 

 
The alignment of the text. 

Position 

 

The position of the text body. 

Blink Select blink effects to make the text blink. Color switching changes the color of the text from 
its original color to the color of the background. Text On/Off displays and hides the text. 

Shape BG Color The BG color of the object’s shape for the current state. 
<Edit Box> / 
<Combo Box> The text for the selected state in current language. Text 

 /  Click  to view and edit the text for the selected language in this edit box, or click  to 
select a text from dropdown text table that lists all the texts from Text Database. You can 
change the text database before selecting a text.  

Line Spacing The distance (in pixels) between two adjacent lines of the text. 
Character Spacing The distance (in pixels) between two adjacent characters of the text. 
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4.3.7. Picture Settings 
This section describes how to define the picture settings for the following types of objects: 

Multi-state Switch, Radio Button Group, Step Button, Page Selector, Multi-state Lamp, Picture Display, and Animated 
Graphic. 

 
The property sheets of the above mentioned objects provide you the Picture page to define the picture settings of the 
objects. The following is an example of the Picture page. 

 
The following table describes each property in the Picture page. 

Property Description 
Picture The name of the current picture. You can use the drop-down list to select a picture from the picture 

database. 
Click  to select a picture from a file as the current picture. After the selection, the software imports 
the picture of the selected file and saves the picture in the picture database. 
Click  to bring up the Select/Import from Library dialog box. Select a picture from a picture library 
file as the current picture. After the selection, the software imports the selected picture from the 
selected library and saves the picture in the picture database. 

  Continued
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Property Description 

Transparent Check this item to make parts of the current picture transparent. The transparent parts are pixels 
whose colors are identical to the specified transparent color. This item is available when the current 
picture is not a black and white picture. 

Transparent 
Color 

The transparent color. 

FG Color The color to paint the black part of a black and white picture. This item is available when the current 
picture is a black and white picture. 

BG Color The color to paint the white part of a black and white picture. This item is available when the current 
picture is a black and white picture. 

Flip/Rotate Specifies the method to flip or rotate the current picture before drawing it. There are 8 options: 
Method Description 
0° No rotation 
90° Rotates the picture clockwise by 90 degrees 
180° Rotates the picture clockwise by 180 degrees 
270° Rotates the picture clockwise by 270 degrees 
X Flips the picture over the X axis 

90° & X Rotates the picture clockwise by 90 degrees and flips it over the X 
Axis 

Y Flips the picture over the Y axis 

90° & Y Rotates the picture clockwise by 90 degrees and flips it over the Y 
Axis  

Tone Check this item to tone the current picture. 
Toning Color The color to tone the current picture. 
Fit to Object Check this item so the current picture can change its size automatically to fit inside the border of the 

object’s shape. 
Position 

 

The position of the current picture within the object. 

Shape BG 
Color 

The BG color of the object’s shape for the current state. 
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4.3.8. External Label Settings 
This section describes how to set up the external label for the following types of objects: 

Bit Button, Toggle Switch, Screen Button, Slide Switch, Word Button, Multi-state Switch, Radio Button Group, Step 
Button, Numeric Entry, Numeric Display, Advanced Numeric Display, ASCII String Entry, ASCII String Display, Bit 
Lamp, Multi-state Lamp, Message Display, Picture Display, and Bar Graph. 

 
You can use the External Label page of an object's property sheet to set up the external label of that object. The following 
is an example of the External Label page. 

 

 
 

The following table describes each property in the External Label page. 

Property Description 
Plate Style Specifies the plate type of the external label. There are four plate types as shown 

below: 
Plate Type Example 

Transparent, 
 

Flat, 
 

Outlined 
 

Raised 
  

Continued 
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Property Description 
Position Specifies the position of the external label relative to the object. There are four 

positions as shown below: 
Position Example 

Top 

 

Left 
 

Right 
 

Bottom 

  

Border The border color of the plate. To specify the color, click the corresponding Color icon 
and select a color from the Color palette. 

Plate The color of the plate. To specify the color, click the corresponding Color icon and 
select a color from the Color palette. 

Color 

Text The color of the text. To specify the color, click the corresponding Color icon and 
select a color from the Color palette. 

Language The language that you are setting the text to. 
<Drop-down List> The font of the text for the current language Font 

 
Click this button to bring up the Font Templates dialog box and select a font for the 
text. You can change the font templates before selecting a font in that dialog box. 

<Edit Box> / 
<Combo Box> The text for the current language. Text 

 /  Click  to view and edit the text for the selected language in this edit box, or click 

 to select a text from dropdown text table that lists all the texts from Text 
Database. You can change the text database before selecting a text.  

 The alignment of the text. 

Border The distance (in pixels) between the plate border and the text body. 
Line The distance (in pixels) between two adjacent lines of the text. 

Spacing 

Character The distance (in pixels) between two adjacent characters of the text. 
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4.4. Setting up Objects 

4.4.1. States of Objects 
When an object has multiple states, its appearance automatically has the same number of corresponding states. You need 
to specify the settings of the shape and the inner label of an object for each state. Usually the state of an object is 
determined by the value of the variable it monitors. An object that monitors a bit has state 0 (off) and state 1 (on). An object 
that monitors a word or a double-word can have up to 256 states. 

 

4.4.1.1. State Types 
You need to specify the state type of an object so the object knows how to determine its state. The following table 
describes each of the four state types. 

State Type For How to decide the state 
Bit Bit Variable The state is the value of the variable. 

Example: 
1) The state of $U1.3 is 0 when $U1.3 is 0 (off). 
2) The state of WX3.f is 1 when WX3.f is 1 (on). 

Value Word Variable, 
Double-word Variable 

The state is the value of the variable. The valid states are from 0 to 255. 
Example: 

1) The state of $U200 is 123 when $U200 is 123. 
2) The state of WX20 is 0 when WX20 is 0. 
3) The state of $N300 is invalid when $N300 is 999. 

LSB Word Variable, 
Double-word Variable 

The state is the number of the least significant bit of the variable’s value that is 1 
(on). For a word variable, the valid state are from 0 to 16 and state 16 means all 
the bits are 0. For a double-word variable, the valid state are from 0 to 32 and 
state 32 means all the bits are 0. 
Example: 

1) The state of $U200 is 1 when $U200 is 246H. 
2) The state of WX20 is 19 when WX20 is 80000H. 
3) The state of $N300 is 16 when $N300 is 0. 

Custom Word Variable, 
Double-word Variable 

When you configure an object with the Custom state type, you assign each valid 
state a unique number which is called a state value. The assigned state values 
will be used to determine the state of the object. If the variable’s value is equal to 
one of the state values, the corresponding state of the state value is the state of 
the object. If the value is equal to none of the state values, the state is invalid. 
Example: 
An object monitors $U100 and its state type is Custom. There are three valid 
states and you assigned 300, 200, and 100 to state 0, 1, and 2 respectively. The 
state is 2 when $U100 is 100 and the state is 0 when $U100 is 300. 
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4.4.1.2. Setting the Custom States of an Object 
In the General page of the object’s property dialog box, with the Custom state type selected, click the 

 button to bring up the Custom State Value dialog box as the example shown below. 

 

             
 

You can assign a positive integer for each state in the dialog box. To edit the value, click the row of that state under the 
value column.  

You can use the Move Up button and the Move Down button to adjust the position of state values. To move up or move 
down the state values, you need to make a selection first. To select a state, click the header column. To select multiple 
rows, click the header column and use Ctrl+Click to add a row to the selection. 
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4.4.2. Operation Options of Objects 
The following table explains operation options which can be added to an object to make it more informative, secure, and 
useful.  

Terminology Definition 
Enabling and disabling the 
touch operation 

The touch operation can be enabled and disabled either by a specified bit or by the 
current user level. You can choose to display the touch operation disabled sign on the 
button when the touch operation is disabled. 
 
If the touch operation is to be enabled by a bit, you need to specify that bit and the bit 
value that enables the touch operation. 
 
If the touch operation is to be enabled by the current user level, you need to specify the 
lowest user level that is required to enable the touch operation. 
 
Select and set this feature in the Advanced page of the Bit Button dialog box. 

Requiring the minimum hold 
time 

The touch operation will not be activated until the button is pressed and held down for 
the specified Minimum Hold Time. 
 
Select and set this feature in the Advanced page of the Bit Button dialog box. 

Requiring the operator 
confirmation 

A confirmation dialog box is displayed when the button is activated for setting a bit. The 
button will proceed to set that bit if the operator selects “Yes” to confirm the operation. 
The touch operation will be cancelled if the operator selects “No” to reject the operation 
or if the operator does not respond within the Maximum Waiting Time. 
 
This feature is available for the following operations: 
Set ON, Set OFF, Set ON Pulse, Set OFF Pulse, and Invert. 
 
Select and set this feature in the Advanced page of the Bit Button dialog box. 

Notifying a bit of the touch 
operation 

The notification is performed after the touch operation is done. You need to specify the 
bit to be notified and the bit value to be used for the notification. 
 
Select and set this feature in the Advanced page of the Bit Button dialog box. 

Logging the touch operations The time and date when the touch operation occurs, the new value that is written to the 
bit, and the predefined text can be recorded in the operation log with this feature. 
 
Select and set this feature in the Advanced page of the Bit Button dialog box. 

Showing and hiding an object The visibility of an object can be controlled either by a specified bit or by the current 
user level, i.e. an object can be shown and hidden dynamically by any of these two 
methods. 
 
If visibility is to be controlled by a bit, you need to specify that bit and the bit value that 
shows the object. 
 
If visibility is to be controlled by the current user level, you need to specify the lowest 
user level that is required to show the visibility. 
 
Note 1: When an object is invisible, the touch operation is automatically disabled. 
Note 2: It is allowed to simply set an object as invisible. The touch operation is still 
enabled with this setting. 
Select and set this feature on the Visibility page of the object setting dialog box. 
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4.4.3. Address Settings 
This chapter describes the terms, rules, and methods to address data. 

4.4.3.1. Terminologies for Data Accessing 
The following table explains variables, addresses and tags. 

Terminology Definition 
Internal memory The memory space in the target panel that can be accessed by the panel application. For 

example, the user memory $U, the non-volatile memory $N, the system memory $S, and 
the recipe memory $R are all parts of the internal memory. 

Internal variable An address or a tag referring to an address of a space in the internal memory. 
Internal bit variable An internal variable that refers to a bit in the internal memory.  

 
Note: “Internal variable” instead of “internal bit variable” is used when referring to a bit if 
there is no ambiguity. 

Internal word variable An internal variable that refers to a word in the internal memory. 
The variables can also be used to refer to a double-word, a block of bytes (byte array), a 
block of words (word array), and a block of double-words (double-word array). 
 
Note: “Internal variable” instead of “internal bit variable” is used when referring to a bit if 
there is no ambiguity. 

External memory The memory spaces or the collections of addressable devices in the controllers that can 
be accessed by the panel application through communication links. 

External variable An address or a tag referring to an address of a space in the external memory. 
External bit variable An external variable that refers to a bit in the external memory. 

 
Note: “External variable” instead of “external bit variable” is used when referring to a bit if 
there is no ambiguity. 

External word variable An external variable that refers to a word in the external memory. 
The variables can also be used to refer to a double-word, a block of bytes (byte array), a 
block of words (word array), and a block of double-words (double-word array) if the access 
unit of the associated addresses is word. If the access unit is double-word, you can only 
use the variable to refer to a double-word or a block of memory space with a length of a 
multiple of 4 (bytes). 
 
Note: “External variable” instead of “external bit variable” is used when referring to a bit if 
there is no ambiguity. 

Variable An internal variable or an external variable. 
Bit variable An internal bit variable or an external bit variable. 
Word variable An internal word variable or an external word variable. 
Double-word variable An internal variable or an external variable that refers to a double-word. 
Byte array variable An internal variable or an external variable that refers to a byte array. 
Word array variable An internal variable or an external variable that refers to a word array. 
Double-word array variable An internal variable or an external variable that refers to a double-word array. 
Tag A name that stands for an address of the internal memory or the external memory. It also 

specifies the data type and scan rate of the data in the memory location it refers to. 
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4.4.3.2. Address Input Keypad 

With the address input keypad, you can enter an address easily. Usually, you click  to bring up the address input 
keypad as shown below. 

 

 

 

 

 

 

 

 

 
 

 
Property Description 
Link Click the down arrow and select a link from the drop down list. 
PLC 
Address 

Click the down arrow and select a value between 0 and 255 or 
an indirect address between [$I0] and [$I15] as the PLC 
Address. If an indirect address is used, the plc address can be 
dynamically changed. 

Location 
Type 

Click the down arrow and select an item from the drop down list 
as the location type. 

CHAPTER 4   DESIGNING SCREENS

Address Specify the address. 
Input 
keypad 

 
Buttons Description 

 
Clears all the texts in the address field. 

 
Deletes all selected texts, if any, or the text 
character to the left of the cursor in the address 
field. 

 
Cancels the address input and escapes the 
dialog. 
Checks and enters the address if valid. 

Others Click to specify the address. Only available 
when the Address field holds the input focus.  

 
Click the help button to see how to specify word or bit devices 
and their addresses for the specified link in the following 
pop-up dialog. 
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4.4.3.3. Selecting Tags 

To select a tag, you can click  to bring up the Select Tag dialog box as shown below. 

 

  

Tag group 

Selected tag 

All the predefined word or bit tags for the 
selected link are listed. To use a tag, you 
can double click the tag you want or select a 
tag and then click the OK button. 

The address for the selected tag 

 

Note: All the listed tags and tag groups are created in the Tags Editor. To create a tag, please see Section 2.3 Working with 
Tags. 
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4.4.4. Scale Settings 
This section describes how to set up the scale for the following types of objects: 

Slide Switch, Bar Graph, Circular Bar Graph, and Meter. 
 
The following are examples of scales used in different kinds of objects. 

 Slide Switch Circular Bar Graph 

 

Major 
ticks Marks 

Axis Bar Graph Minor 
ticks 

You can use the Scale page in an object's property sheet to set up the scale of that object. The following is an example of 
the Scale page of the bar Graph. 
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The following table describes each property in the Scale page. 

Property Description 
Scale Check this item if you want the object to have a scale. 
Position Specifies the position of the scale in the object. The position is relative to the part of the 

object that displays the monitored variable. There are six positions shown below: 

Position Example Position Example 

Top 
 

Bottom 

 

Left 

 

Right 

 

Inner 

 

Outer 

 
  

Color The color of the scale. To specify the color, click the corresponding Color icon and select a 
color from the Color palette. 

Number of Major Ticks The number of major ticks. The minimum you can specify is two. 
Number of Sub 
Divisions 

The number of divisions between two adjacent major ticks. The minimum you can specify is 
one.  

Axis Check this item if you want the scale to have an axis. 
Marks Check this option if you want the scale to have marks. 
Font The font of the marks. 
Dynamic 
Range 

Check this option if you want the minimum and maximum of the marks to be controlled by 
the dynamic range parameter block of the associated object at runtime. 

Minimum The minimum of the marks. It is a 32-bit integer. 
Maximum The maximum of the marks. It is a 32-bit integer. 
Total Digits The total digits to be displayed for the marks. 

Marks 

Fractional 
Digits 

The number of fractional digits for the marks. For example, when the Maximum = 5000, the 
Total Digits = 4, and the Fractional Digits = 2, the mark for the Maximum will be 50.00. 
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4.4.5. Advanced Settings 
This section describes how to define the advanced settings for the following types of objects: 

Bit Button, Toggle Switch, Screen Button, Function Button, Slide Switch, Word Button, Multi-state Switch, Radio 
Button Group, Step Button, Advanced Numeric Display, ASCII String Entry, and Recipe Selector. 

You can use the Advanced page in an object's property sheet to define the advanced settings of that object.  

 

The following are examples of the Advanced page for different objects: 

For an advanced numeric display. For a bit button. 

 
 

The following table describes each property in the Advanced page. 

Property Description 
Enabled by Bit Check this option so the touch operation of the numeric entry will be enabled and 

disabled by the specified bit. 
Control Bit Specifies the bit that enables and disables the touch operation.  

Click  to enter a bit address. Click  to select a bit tag. 
Enabling State Specifies the state (On or Off) that enables the touch operation. 
Enabled by 
User Level 

Check this item so the touch operation of the numeric entry will be enabled and 
disabled by the current user level. 

Lowest 
Enabling User 
Level 

Specifies the lowest user level that is required to enable the touch operation. 

Touch 
Operation 
Control 

Show Disabled 
Sign 

Check this option so the touch operation disabled sign will be shown on the numeric 
entry when the touch operation is disabled. 

Continued
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Property Description 

Timeout Check this option so the data entry will be cancelled if the numeric keypad does not 
receive any input within the specified time. 

Timeout 

Timeout Time Specifies the maximum time that the numeric keypad will wait to receive a new input. 
If there is no input within the specified time, the numeric keypad will be closed and 
the data entry will be cancelled. 

Notification Check this option so the numeric entry will notify the specified bit after it finishes 
outputting the entered value to the destination variable. 

Signal Select one of the following signals for the notification: 

Signal Description 
Level Set the specified bit to the specified state. 
Pulse Send a positive pulse to the specified bit.  

Bit Specifies the bit that receives the notification. 

Notification 

State Specifies the state (On or Off) that is used for the notification. 
Operator 
Confirmation 

Check this option if you want the operator to confirm what he/she enters for the 
numeric entry. The Confirmation box will be displayed when a value is entered for 
numeric entry. If the operator selects “Yes” in the Confirmation box, the numeric 
entry will write the entered value to the specified variable. If the operator selects “No” 
or if the operator does not respond within the specified time period (Maximum 
Waiting Time), the numeric entry will cancel the data entry operation. 

Operator 
Confirmation 

Maximum 
Waiting Time 

Specifies the maximum time that the numeric entry will wait for the operator’s 
confirmation. The data entry will be cancelled if the operator does not respond within 
this time. 

Operation 
Logging 

Check this option so the following three items will be recorded in the operation log 
when the numeric entry outputs the entered value. 
There are three recorded items: 
1) The time when the operation is performed 
2) The entered value 
3) The predefined operation message 

Message Enter the operation message of the first language here. 

Operation 
Logging 

 
Click this button to bring up the Operation Message dialog box that you can edit the 
operation message for all the languages. 

Minimum Hold Time Available when the object is a button or switch. The touch operation of the button will 
not be activated until the button is pressed and held down for the specified time 
period (Minimum Hold Time). 
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4.4.6. Visibility Settings 
In the Visibility page of an object's property sheet, you can define how to show and hide the object. You can also modify 
the position and size of an object with the Visibility page. 
 
The following are examples of the Visibility page: 

The option “Controlled by Bit” is checked The option “Controlled by User Level” is checked 

The following table describes each property in the Visibility page. 

Property Description 
Invisible Check this option so the object will always be invisible. 

Note: The touch operation is still enabled with this setting. 
Controlled by Bit Check this option so the object will be shown and hidden by the specified bit. 
Control Bit Specifies the bit that will show or hide the object.  

Click  to enter the bit address. Click  to enter the bit tag. 

Controlled 
by Bit 

Visible State Specifies the state (On or Off) that makes the object visible. 
Controlled by 
User Level 

Check this option so the object will be shown and hidden by the current user level. Controlled 
by User 
Level Lowest Visible 

User Level 
Specifies the lowest user level that is required to show the object. 

Left Specifies the X coordinate of the object’s upper-left corner on the screen. 
Top Specifies the Y coordinate of the object’s upper-left corner on the screen. 
Width Specifies the width (in pixels) of the object. 
Height Specifies the height (in pixels) of the object. 

Dimension 

 Click this button to redraw the object with the new settings. 
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